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ArtworkWhat’s It For

Art Creation
Illustrator is a computer program for creating artwork. Its basic 
mechanism is an outlined shape. Illustrator is “vector based,” 
meaning it retains knowledge of the shapes you draw, like a CAD 
program and unlike “pixel based” image editing software such as 
Photoshop.

Having every mark stay in the drawing as a modifiable element is 
very powerful and offers great flexibility.

Ilustrator also supports text and bitmapped images

While at first Illustrator may seem suitable only for hard edged 
diagrammatic work, it is also capable of rather painterly effects and 
in the right hands even photorealism (see page 3).

          

So when should you use Illustrator?

•	 when you are creating a single piece of artwork, such as a 
diagram, or map.

•	 when you want to modify or add content to a hard line 
drawing; perhaps adding entourage and color washes to a 
SketchUp drawing.

•	 when you want to trace something
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What’s It For That Computer Look

Clean
Trying to explain Illustrator, the word “clean” keeps coming to the 
foreground. Sure, Illustrator can be messy and ornate, but with its 
basis in outlined shapes and its ability to handle gradients and text 
with repeatable predictability combine to make Illustrator very 
strong at crisp, simple... clean art.

Overlap
Yes, there is overlap with other Adobe products. But the primary 
strengths are still:

•	 Photoshop - photographic image manipulation
•	 Illustrator - clean outline based artwork
•	 InDesign - type and document creation

 Experience and an awareness of when something is getting too 
annoying are what tell you which program to use.
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What’s It For Photoreal

Just Wow
This image is just to emphasize that Illustrator is very capable.
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What’s It For Photoreal

Not Kidding
Here is the line work to try to prove that really is a vector illustra-
tion.
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Interface Elements Using

Menu

Control Bar

Ruler

Panel

Document

Tool Bar

Practice
Open up an existing file to help get a feel for the interface. Don’t 
worry, it takes extra effort to mess anything up.

Lots Stuff  to Click On
Illustrator uses the standard Adobe Creative Suite interface with 
six main areas:

•	 Menu - Commands for managing and manipulating the 
document and its contents.

•	 Tool Bar - Easy buttons for object creation and manipulation
•	 Document - The workspace that shows your creation.
•	 Panels - Where most of the action is.
•	 Control Bar - Options and tools related to the current tool 

or selection.
•	 Ruler - helps with accurate object placement. The ruler can be 

toggled on the View menu or by hitting Ctrl-R.

It’s All On The Window Menu
Most of what you want to do resides on panels. Since panels can 
be closed and moved around, it can be easy to lose track of a handy 
command. When you lose something, look for its panel on the 
Window menu. Everything is there and it’s probably where the 
thing you want is.

Rearrange
The panels system is very flexible. 

Panels can be rolled up by clicking on the blank gray area next to 
the individual panel names. 

Whole panel panes can be collapsed by clicking the tiny double 
arrow icon on the dark bar at the upper right. 

Panels can reordered, torn off and docked by grabbing their tabs. 
As you move them around, watch for the blue highlighting in the 
UI to show you how they are going to arrange.
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Interface Elements Using

What’s Best
How to arrange the interface is a matter of general efficiency com-
bined in large part with personal preference and a dose of current 
task.

Illustrator provides Workspaces to save different interface con-
figurations. You can access them on the Window menu or use the 
dropdown in the upper right. You can see here that I have made my 
own workspace to remember the panels just the way I like them.

No Really, What’s Best?
Recommended panels to start with:

•	 Color
•	 Swatches 
•	 Stroke
•	 Graphics Styles
•	 Appearance

Or

•	 Workspace: Essentials - is pretty good.

You’ll soon find others that you want to keep around. Later when 
you find your stride, you will start organizing them into different 
task based Workspaces and you’ll really start to own the interface.

The Control Panel and Toolbar can be moved, floated, docked in 
strange places but so many programs are organized similarly that it 
probably is not worth breaking with tradition. On the other hand, 
maybe it’s nice to have all the things to click on clustered in one 
part of the screen.

Panels can also be moved to a different monitor if you have one 
available.
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 Navigation - Zoom and Pan Using

Pan - Spacebar

Zoom - Alt-Wheel, Ctrl-Equals ...

Moving About A Page
Navigation in InDesign is pretty easy. Since the page is two di-
mensional there are only pan and zoom controls to worry about. 
There are explicit tools for these functions but it is good to use the 
keyboard shortcuts. 

•	 Pan - hold down the spacebar to bring up the pan tool. Unless 
you are typing text, in which case holding down the spacebar 
makes a lot of spaces. 

•	 Zoom - the Z key gets the zoom tool. Ctrl-Equals and Ctrl-
Minus (I think of it as plus and minus, but the ‘+’ is actually 
shifted version of the ‘=’ key) will always zoom in out one step 
at a time.

•	 Fitting - Ctrl-Zero zooms so the current artboard fits in the 
window with very little white space around it. Ctrl-Alt-Zero 
zooms to show all artboards. There are a number of other fit-
ting options which you can browse on the View menu. In 
time you will decide how you like to work.

Even More
Note that double clicking on the Zoom button zooms to 100% 
and double clicking on the Pan button zooms to current artboard.
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Some Tiny DetailsUsing

New Button

Tear Off Button

Fly-out Menu Fly-out Menu. Click and hold.

Ruler

Panel Menu Button

Fly-Out Menu
You’ll notice that some of the toolbar buttons have a little black 
triangle on them. This indicates that if you click and hold (or right 
click) on this button you will get a menu with other, related, but-
tons. For instance, the Rectangle button is part of the Shape group 
which also includes seven other shapes.

Whichever button you last used in a group appears on the toolbar. 
This can get a little confusing. Sometimes you have to hunt “under” 
the buttons to find the tool you are looking for. With a little expe-
rience you learn which tools are grouped together.

Tear Off  Button
In Illustrator the flyout menus show a narrow button at their right 
edge. Click this to turn the menu into a floating panel. This is 
especially useful for the Pen and Direct Select menus when you 
are editing shapes.

New Button
Many panels contain lists of things you can create. At the bottom 
of each panel is a row of buttons. There’s a trash can for deleting 
items. Often there’s a new button which may not be obvious to the 
new user. I think it looks like somebody peeling off the top sticky-
note to get a brand new one.

Panel Menu
Every panel has its own associated menu in the upper right corner 
on the light gray next to the panel tabs. Lots of useful stuff hides 
here.

Ruler Units
By default the ruler is measured in sixths of an in (picas). You can  
change this. Either go to the menus, Edit: Preferences: Units & 
Increments where you can change the ruler units (but don’t change 
type units, you are already familiar with using points for that). Or 
you can right click on a ruler and change its units right there in 
the interface. You can do each ruler separately or right click at the 
corner where they meet to do both at the same time.
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Some More Tiny DetailsUsing

The None swatch.

Panel Expander

Preview

They may look the 
same...

But one is filled with None. 
The other with white.

Preview
Many of the dialogs in InDesign have a Preview checkbox. Turn 
it on. 

Panel Expander
Some Panels have different configurations. The ones that do have 
this button right next to the panel name. Click on it to show more 
or different options for a panel. If you find yourself thinking “I 
thought there was a tool for that on one of these panels” you may 
be right. Click a few Panel Expander buttons and you may find the 
missing tools.

The Color of  No Color
Rather than have a separate settings for whether something should 
have a color and what that color is, InDesign just has a special color 
called None. It shows in Swatches as white with a red diagonal line. 
It doesn’t show in your artwork. There’s nothing there. Its name 
is always None. You can not change the name or the color. Why 
would you want to?



10Gateway Software Workshop
Illustrator

 Navigation - ArtboardsUsing

Artboard tool

Related Artwork
Illustrator does not have a concept of a sequence of pages. It offers, 
instead, Artboards. An Artboard is just special area on the draw-
ing surface. They are useful for organizing a project, for exploring 
variations. Artboards are also used like pages for exporting to PDF 
and for importing to InDesign.

For instance, the different illustrations on page 26 are all in the same 
Illustrator file but each on a different artboard. This made creating 
them and bringing them in to InDesign easy by keeping them all 
in the same place but able to be treated separately.

For the project at the left, I was able to work on variations of the 
business card and shirt pocket without having to switch around a 
bunch of different files. When I was ready for client feedback, I 
only had to export one PDF which he was able to page through.

How
Click on the Artboard tool and you can edit Artboards. Artboards 
are always rectangles. Click and drag on empty space with the Art-
board tool to create a new Artboard. Click and drag on an existing 
artboard to move it. Click and drag on an existing Artboard’s grips 
to resize it. Click on the little ‘x’ at the upper right of an exist-
ing Artboard to delete the artboard, but not the art inside it. The 
Delete key works too.

Move an artboard while holding down Alt to make a copy of both 
the artboard and all of its contents.

When you move an Artboard, any artwork even partly inside of it 
moves with it.  If you have overlapping Artboards Illustrator does 
not keep track of which Artboard owns which art. This can be 
surprising at first. It is probably best just not to overlap artboards.

But wait...

It is possible to use Illustrator for years and years without ever even 
knowing or caring about artboards.
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New Document DialogDocument Creation

Let’s Make Something
Illustrator’s starting dialog has an option to create a new document, 
or you can find it on the File menu.

What Values?!
The New Document dialog can be a little daunting at first, espe-
cially if you click the More Options button. Turns out it isn’t that 
bad. There are only two settings you need to look at:

•	 Width - How wide you want the artboard to be.
•	 Height - How tall you want the artboard to be.

If you need to later you can just use the Artboard tool to change 
the size. Here’s the rest of the settings if they interest you.

•	 Name - Will be used when you save. If you want. Can be 
ignored safely.

•	 Document Profile - You can pick the word that sounds most 
like what you are making the art for, but I don’t know about 
this.

•	 Number of Artboards - If you are just creating one picture 
leave this at 1. If later you start making alternates you can just 
add Artboards.

•	 Size - There are some handy presets in here if you want.
•	 Units - Pixels for screen, probably inches for print.
•	 Orientation - Swaps Width and Height if they need to be.
•	 Bleed - Ignore this.
•	 Color Mode - Probably best to use RGB for screen and 

CMYK for print. I think I’ve always used RGB and it’s been 
okay. 

•	 Raster Effects - Affects apparent quality of things like Drop 
Shadow. Use 72 ppi if working for screen, 150 or 300 ppi if 
going to print.

•	 Preview Mode - Leave on Default
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Basic Shape ToolsShape Creation

Line

Brush

Rectangle

Ellipse

Polygon

Star

Fresh
Time to start making things. Create a new document and let’s get 
drawing.

The Basics
Illustrator includes tools for creating various common shapes. 
Sometimes these shapes are all you need. Maybe you have to add 
some simple transformations. They are a good place to start be-
cause the are easy to understand and fairly predictable.

Try them all out.

Click vs. Drag
If you select a shape tool the click and let go on the canvas, Illustra-
tor gives you a dialog to enter the shape size numerically.

If you click and drag, Illustrator lets you draw out the shape.

Appearance
You can change appearance settings while nothing is selected and 
new shapes are drawn with that appearance. See page 19 for more 
information on appearance.



14Gateway Software Workshop
Illustrator

ModifiersShape Creation

Click and drag

Shift-Drag

Alt-Drag

Alt-Shift-Drag

Space-Drag

Make a Shape
Pick the Rectangle tool or maybe the Ellipse tool on the fly-out 
menu (see page 8).

To make a shape just click and drag on your document somewhere. 
This draws the shape from corner to corner.

Make a Shape Differently
If you hold down Shift while making a shape, it’s width and height 
are forced to be equal. This makes rectangles into squares and el-
lipses into circles.

If you hold down Alt while making a shape the first point you 
clicked becomes the center, not a corner.

You can hold down Shift and Alt at the same time.

If you hold down space while creating a shape you can move the 
shape before it is finished. This is great for tweaking position as you 
go. Yes, it really is better than just making the shape then moving it.
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Pen ToolShape Creation

Pen Tool

Convert Direction Point Tool

Add Anchor Point Tool

Delete Anchor Point Tool

Direct Selection Tool

Click and Drag
The Pen tool is for making complex shapes by manually placing 
and smoothing all the corners.

A shape in Illustrator has Anchor Points, these are points through 
which the shape must pass. An Anchor Point has Handles that 
describe the amount of curve and its direction as the shape passes 
through the Anchor.

If you click with the Pen tool you get a hard corner. If you click and 
drag, you get a smooth curve with extended Handles.

Don’t worry about making a mess, most of us find the pen tool 
hard to get used to at first.

Adjust
Use the Direct Selection tool (the white arrow) to select Anchors 
and Handles and adjust them. If you hold down Shift while adjust-
ing a Handle, it snaps to 45 degree angles.

Unlike in InDesign you can use the Alignment panel on individual 
Anchors. Direct Select a few anchort then hit the appropriate 
Align button. See page 44 for more information on Align.

Further Adjust
Use the Add/Delete/Convert tools to further adjust your shapes. 
Add and Delete Anchor tools do just what they suggest. You have 
to pick pretty close to a shape or anchor for InDesign to figure out 
what you want to do.

The Convert tool does three related things.

•	 Click on an Anchor and let go - it removes that Anchor’s 
Handles and makes the Anchor a sharp corner.

•	 Click and drag on an Anchor  - it drags out new Handles and 
makes that Handle smooth.

•	 Click and drag on a Handle - it breaks the smooth line 
between the handles, making a sharp point but it keeps the 
handles.
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An Exercise Left to the StudentPen Practice

Just click to start.

Click once.
Click on the same point
and drag out a handle.

Click once.
Click on the same point
     and drag out a handle.

Click once.
Click on the same point
      and drag out a handle.

Click and
to the right to
make the first half
of the handle, now
keep the mouse button
held down and press the
Alt key on the keyboard, keep
it held down and move the
mouse down and to the
left to make the second half
of the handle.

This time, click and drag first
to make the handle. Then just

      click the same point again.

11

22

33

44

55

66

End by clicking once
on the first point.

77

Do I Have To...?
If you are going to use Illustrator it won’t be long before you want 
to tweak a shape. Then one day you will want to draw your own 
shape. So get some practice in now so you get a little familiar with 
the pen tools.

To the Left
Here are and on the next page are some exercises to work on in 
your spare time. At least try to use the Pen tool to make a circle. It’s 
fun. Go on, I dare you.
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An Exercise Left to the StudentPen Practice

Click and drag, then click 
again on the same point. 
(Or Click then Click-Drag)

Click, drag then hold alt 
to make corner handles

Click and drag,Click

Homework That Will Never Be Checked!
You don’t have to do it but it is good for you.

Snap Angles
Hold down shift to snap the handles to 0, 45, and 90 degree angles.

What’s the Red Stuff?
This is a first try at making a visual language for the different ways 
you can use the pen tool. An Anchor isn’t simply an Anchor. It 
may be a hard corner, a hard corner with tangent Handles, smooth 
with Handles... Each of these different Anchor conditions has a 
different way to create it as you draw. These red annotations are a 
way to help specify what to do at each Anchor.

The system is flawed:

•	 This form:  - is used to indicate click-drag-click  
and click-click-drag.

•	 Fourth row - with the big arcs and little arcs you need to click, 
drag out a handle then without letting go hold down alt and 
drag out the other half of the handle.
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Select Move Rotate SizeManipulating Objects

Rotate

Scale

Move / Duplicate

Rotate

Scale

Selection / Move / Duplicate

Reference Point Tool Reference Point Marker

Move
The Selection tool (black arrow) also works as the Move tool in 
Illustrator. Just click and drag on an object.

Duplicate
If you hold down Alt while moving something, it makes a copy.

Rotate
The rotate tool spins things around on the page.  If you hold down 
Alt after you start rotating, it makes a copy. If you hold down Shift 
after you start rotating, it snaps the rotation to 45 degree incre-
ments.

You can also rotate with the Selection tool by clicking near the 
corner grip of an object. Watch for the cursor to change.

Scale
The scale tool changes the size of things.  You can also change the 
size of something by selecting it and then dragging the grips that 
appear.

Reference Point
Rotation and scaling always happen “about” some center. The point 
which stays where it is. You can set this point two ways.

•	 Click - With the Rotate or Scale tool selected just click 
anywhere in on the document to change the Reference Point 
Marker.

•	 Tool - With the Rotate or Scale tool selected the Reference 
Point Tool appears on the Control panel. You can use this so 
specify corners, edge midpoints, or object center.

Wait - There’s More
The Control panel has lots of controls on it for transforming ob-
jects. If you know you want to rotate something exactly 27 degrees, 
do it there. If you know you want something positioned exactly 
2.718 inches from the left margin, do it there.
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Resize vs. ScalingShape Manipulation

Original

Scale - Shift held down

Resize - No modifier keys

With Scale Strokes & Effects

Without Scale Strokes & Effects

Only One Way
Unlike InDesign, Illustrator has only one idea for changing the 
size of an object. There are different physical mechanisms, you can 
move grips to stretch an object to a new size or you can use the 
scale tool to shrink/grow it, but in the end the result is the same.

Proportions
Use the Select tool and the grips on an object. If you hold down 
Shift the object will be resized proportionally. Its shape will not 
distort. If you hold down Alt after you start resizing an object it 
will resize about the object’s center, not the opposite corner.

Stroke Weight
When you resize an object you will notice that patterns applied to 
the object resize with it, but the stroke weight remains constant. 
This can be changed.

On the Transform panel there is a checkbox for “Scale Stroke 
and Effects” that will resize stroke weight in keeping with the 
new object size. Also such effects as Drop Shadow distance and 
amount of  Roughness. 
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Pathfinder PanelShape Combination

Original shapes

Unite

Minus Front

Intersect

Divide

Trim (expanded 
for clarity)

Merge (expanded )

Exclude

Divide (expanded for clarity)

Crop

Outline

Minus Back

How
Make some shapes. Select them all and then press a Pathfinder 
button.

•	 Add - is straight forward.
•	 Minus Front- removes all of the shapes from the rearmost 

shape. Only areas of the rearmost shape with nothing in front 
of them remain.

•	 Intersect - retains only the area where all shapes overlap.
•	 Exclude - keeps only the places where an odd number of 

shapes overlap. This can lead to some interesting patterns. 
•	 Divide - Cuts every shape by every other shape, even hidden 

ones.
•	 Trim - Removes all of the hidden parts of shapes and clears 

the stroke settings.
•	 Merge - Removes all of the hidden parts of shapes, clears the 

stroke settings and then does Unite for shapes that overlap 
and have the same fill. Note: The example here is not designed to 
show this last step well.

•	 Crop - Removes all areas outside the topmost object. Re-
moves the topmost object. Performs Trim on what remains 
and removes any Stroke.

•	 Outline - Divides objects into groups of edges based on 
where shapes overlap. Similar to Divide but without Fill. Re-
moves Fill, sets Stroke width to zero and Stroke color based 
on fill color.

•	 Minus Back - is like Minus Front but the base shape is the 
frontmost one. Only areas of the frontmost shape with noth-
ing behind them remain.
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What ForShape Combination

Using simple shapes and simple transforms with Pathfinder (Union) 
to make a complex shape.

Using simple shapes with Pathfinder (Minus Front) to make a 
complex shape.

Using simple shapes with Pathfinder to make a complex shape. And 
then some Anchor and Handle tweaks.

Different numbers of overlapping shapes used with Pathfinder’s 
Exclude mode.

Build Up Complex Shapes

If you need a greek cross you could draw it carefully with the pen 
tool, or you could just use Pathfinder to combine two identical 
rectangles. If you need a donut you have to use Pathfinder to 
combine two circles. 

Examples
Just a few simple examples to help illustrate the idea the Pathfinder 
can be used to create more complex shapes than the built in basics 
just by breaking the end result into simple starting shapes.

One More Thing
When you use Pathfinder, Illustrator automatically Groups the 
results. This may be what you want. It may not. You can Ungroup 
them easily. The right click menu has it, the Object menu has it 
and the hot key is Ctrl-Shift-G.
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Layers and StuffDisplay Order

Volunteers Step Forward
Illustrator draws objects one after the other. As one gets drawn, it 
might cover over something that was drawn before. This draw-
ing order gives rise to the idea that objects are “in front of ” some 
objects and “in back of ” others.

By default, objects are drawn in the order they are created. This 
makes newer stuff in front. It is a natural behavior but sooner or 
later you will want to move something either forward or backward. 
Turns out it’s easy. But first...

You can move objects either one step at a time, just in front of or 
behind the next object in the pile, or all the way to the front or back.

How?
There are a number of ways:

•	 Menu - Select an object and on the Object menu, Arrange 
and then pick the movement that you want. The Arrange 
commands are also available on the right click menu.

•	 Keyboard - On the menu you’ll see that there are keyboard 
shortcuts. Backward: Ctrl-[, Forward: Ctrl-], To Back: Ctrl-
Shift-[, To Front Ctrl-Shift-].

•	 Layer Panel - All objects appear in the Layer Panel. The 
drawing order is the same as the list in the Layer Panel. It 
starts at the bottom - the back - and moves to the top of the 
list - the front.

Why?
You may care just for appearance purposes. Sometimes the things 
you draw do go in front of or behind one another logically accord-
ing to the image you want to create.

Also, a number of commands for combining shapes act specifically 
on frontmost or backmost objects.
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Stroke and FillShape Appearance

Color tools.

Typical default appear-
ance. Slim black stroke 
with white fill.

Blue fill with wide 
yellow stroke

Red fill with yellow 
stroke, dashed with blue 
gap color.

Simple line with wide 
blue stroke and red fill.

Wide blue stroke.

Blue fill.

Reset to Default
Swap

Stroke Color
Fill Color

Very Expressive
A shape starts as just an outline, but then it gets an appearance 
applied to it. Every shape has two primary parts:

•	 Stroke - the line that traces around its edge. This line can not 
be drawn or it can have a thickness, called weight, and a color. 
It can also have a Type for a more ornamental look and it can 
be dashed.

•	 Fill - color applied to the area a shape encloses. If a shape is 
open, like a U, then the fill stops at an invisible straight line 
connecting the start and end of the shape.

How
Select an object then change the attributes you want.

You can access Stroke and Fill color on the toolbar. If you double 
click the tiny color indicators a color picker pops up to let you set 
a color. 

Under the tiny color indicators are the even tinier frame and text 
buttons. Text in InDesign lives in a frame and the frame can have 
its own color different from the text. See the next page.

Or you can go to the Color and Stroke panels where the buttons 
are all a little bigger.

The pair of squares represent Fill and Stroke color. Which one is 
in front is the one you are changing. Just click on the one you want 
then pick a new color.

The tiny curved arrow to the upper right of the two squares swaps 
places, Fill becomes Stroke,  Stroke becomes Fill.

The Color panel seems to have a mind of its own. If you go to the 
Panel Menu you can tell it which color picker you want. 

The Stroke panel has all the controls for Stroke Weight, Type and 
even if you want a shape to be an arrow.

Color panel.

Stroke panel.
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Appearance PanelShape Appearance

Appearance Panel

Very Expressive
A shape starts as just an outline, but then it gets an appearance 
applied to of its own. If you go to the Panel Menu you can tell it 
which color picker you want. 

The Stroke panel has all the controls for Stroke Weight, Type and 
even if you want a shape to be an arrow.
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EffectsShape Appearance

Transparency panel

Normal. 100%

Multiply. 100%

Normal. 50%

Overlay. 100%

Simple Transparency
A very common desire is to have text on a transparent frame partly 
blocking out the background but still allowing it to show through. 
This is accomplished on the Effects panel.

If you just open the Effects panel and change opacity to, say, 50% 
the whole thing will fade and your words will be hard to read.

See that “Object” is selected? Select “Fill” instead and change its 
Opacity.

You can also change the blend mode where it says “Normal” for 
Object, Stroke, Fill, or Text.

Typically text is is drawn as appearing in front of the background. 
If you need the text to have a transparency effect that interacts with 
the background but not the frame, Objects and turn on “Knockout 
Group”.
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EffectsShape Appearance

Original

Drop Shadow

Scribble

Radial Blur Twist, Scribble, Drop Shadow Add Arrowhead

3d Extrude and Bevel

Inner Glow

Twist

Roughen

Rounded Corners

Rough Pastels

Other Stuff
On the Effects panel there is a little button with “fx” on it. It hosts 
a long list of effects that can be applied to objects or parts of their 
appearance.

I won’t say they are unsuitable for design documentation, but do 
use them carefully. A bit of drop shadow can help bring something 
forward in a busy situation. A bit of inner shadow is sometimes a 
nice effect on title text. They can also be used to make a diagram 
seem a little more physical... or a little more painterly.

Here is a quick demo of all of them at their most basic and few 
fancier combinations.
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Letting Your Creativity WinShape Appearance

More Other Stuff
Fills and Strokes do not have to be solid colors. They can be Gra-
dients or Patterns...
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Anything You WantShape Appearance

More More Other Stuff
Strokes can be made with Brushes. And Brushes can be pretty 
fancy.



29Gateway Software Workshop
Illustrator

Appearance PanelShape Appearance

Basic Still pretty simple. Same as previous with 
added effects to whole 
object.

Same start, but effects 
added separately to 
Stroke and Fill.

Same start, with Drop 
Shadow added to whole 
object and Opacity ad-
justed only on Fill.

Two strokes, one wider 
and one with a Roughen.

Starting To Get Powerful
The standard panels offer reasonable flexibility but where Illustra-
tor really shines is on the Appearance panel. The appearance panel 
is like a little layer stack for each object. It separates Fill and Stroke 
from each other and allows them to be treated differently. It also 
allows for the creation of multiple Fills and Strokes to be stacked 
on top of each other, reordered. Each item in the Appearance panel 
can have its own effects and Opacity settings.

How?
The basics on the Appearance panel are right there to be adjusted. 
Pretty much everything is clickable. The Eye icon turns items on 
and off. The triangle expands and collapses items to allow access to 
Opacity and Effects. The color pot allows for Swatch selection. The 
Stroke Width indicator allows for Width selection.

At the bottom of the panel is a new button for creating new Fills 
and Strokes. You can also create new items from the Panel Menu.

To add effects, select the item you want to add the effect to - either 
the whole path, Stroke or Fill, or if you select nothing it will get 
applied to the whole object - and click on the “fx” button at the 
bottom of the panel to select your effect.

Effects can be moved from one item in the stack to another. If you 
hold down Alt while moving an effect it makes a copy.

Effects can be adjusted at any time by clicking on their name in 
the stack.

Visibility
The higher up on the stack in the Appearance panel an item is, 
the more to the front it is in terms of visibility. If you are stacking 
Strokes, the wider ones usually go lower in the stack.w
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Patterns and GradientsShape Appearance

Two Fills. Each with its 
own effect.

Two Strokes and a Fill 
with an effect and Blend 
Mode on Opacity. Also 
the Fill has been moved 
above the strokes.

Four Strokes of varying 
width and style turn a 
simple shape into an il-
lustration of a road.

Even More
Here are a few more examples with the Appearance panel. Re-
member - the only thing the user drew for each of these is a single 
nine-pointed star. Everything else is added Strokes and Fills and 
Effects.
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Overlapping and MergingShape Appearance

Separate Objects Grouped Objects

Separate Objects Grouped Objects

One By One Can Be Bad
If you select a bunch of objects and apply a drop shadow or com-
plicated Appearance to them each item is treated individually; 
everything that makes up its Appearance is drawn before the next 
item is drawn. Sometimes that is not what you are looking for.

How?
You can get what you may want by grouping the objects first. 
When you apply an Effect or Appearance to a group rather than 
the individual items, the items are treated as a whole with no one 
being higher than another. Every item that makes up the Appear-
ance is drawn for all items in the group before the next Appearance 
item is drawn.

For instance: The drop shadow is lower than the shapes, so all of 
the drop shadows are drawn and then the shapes are drawn so no 
shape casts a shadow on another.

Layers Too
You can also apply an appearance to a layer for the same effect.
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Use These All The TimeSwatches 

Reusable, Alterable Color
A Swatch is a saved color. You can give a swatch a nice name to 
help you remember what it is for.

Whenever you do anything with color in Illustrator, fill a graphic 
background element, draw an important arrow, color a character 
style... anything, you should consider using a Swatch and not just 
some color you picked off the color picker.

The reasons are meant to make your life better:

•	 Consistency - You don’t want your documents to be a chaotic 
mess. If there is a color used for some purpose it should al-
ways the that color throughout the document. Next time you 
need it you can use a Swatch to just get the exact right color 
in one easy click. “Oh, the swatch named ‘Bldg Shadow Blue’ 
is the one I want.

•	 Modifiability - You don’t have to finalize your colors until 
the very end. If you have 137 pages written and find out that 

“Bldg Shadow Blue” is printing a little dark, you can edit just 
one Swatch, put a little more white and a little less magenta 
and everywhere in the document that color is used gets cor-
rected.

And a third reason:

•	 Ugly Mess - Using Swatches pushes some discipline on you 
and prevents your document from using so many colors it 
looks un-careful.
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Use These All The TimeSwatches 

How
On the Swatches panel select an existing swatch then click the 
New button. A new Swatch is made. Double click on the swatch 
to edit the color and give it a useful name (you have to turn off the 

“Name with Color Values” checkbox, but that’s OK).

...Or...
When you double click on the color chips on the tool bar the color 
picker dialog that comes up has a button on it to Add Swatch. You 
can design a color, hit the button and then do another and another. 
But remember to go to the Swatches panel and change the names.

Modifiability Warning
The default behavior of Illustrator Swatches does not preserve a 
link between artwork and the Swatch that colored it. If you modify 
a Swatch, the artwork remains untouched.

Illustrator does have persistent Swatch capability. See the Swatch-
es here with the white triangle in the corner? Those Swatches 
are linked to the artwork that uses them. They are called “Global 
Swatches”. 

To make a Swatch Global, double click the Swatch to get the 
Swatch Options dialog and turn on the “Global” checkbox.

You can select many Swatches at once and change them all to 
Global at the same time.
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TransportationSwatches 

Moving to Other Programs
If you are going to make art in many programs (InDesign, Illustra-
tor, Photoshop...) that you want to integrated and consistent it is 
good to use the same colors in that art. You can share Swatches 
between different programs by saving to an Adobe Swatch Ex-
change file.

How
Select the swatches you want to save. Use shift to select ranges and 
control to select multiple individual swatches.

On the Swatches panel menu select “Save Swatches.”

Be careful where you save the swatches. In testing every program 
saved somewhere different. You should probably just save the 
swatches to the same place as your project or primary document.
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PlaceAdding Images

Simple But Tedious
Go to the File menu. Pick Place and a file open dialog appears. Se-
lect your image and click the Open button. The image is dropped 
on the page at a size that may be inconvenient. 

You will probably have to Scale it before you can do anything else.

Multiple Images
Illustrator does not allow you to select multiple images in the 
Open dialog for placing. But you can drag and drop multiple im-
ages from your thumbnailer.
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Drop From OutsideAdding Images

Bridge - for finding, placing and managing  images.

Parts Bin
When you build model, you keep a bunch of useful stuff right there 
on the table where you are working. Not stuck in some shoebox 
on a shelf on the other side of the room. Similarly, there are ways 
of keeping your content available and just grabbing it when you 
need it.

Well, it’s really just one way: Have some program that shows you 
your images in their folders on the disk and allows you to drag and 
drop them into your document.

Bridge
Adobe has a program called Bridge that does the job. It has power-
ful features for working with other Adobe products and since it is 
Adobe it can thumbnail PDF and Illustrator files with ease.

Mini-Bridge
Illustrator CS6 does not have Mini-Bridge and it does not appear 
to exist in CC either.

Explorer
If you don’t fancy Bridge, you can use your operating system’s file 
browser. Windows Explorer, Mac Finder or what have you. They 
have ways of showing thumbnails of images and are already famil-
iar to you.

Other
There are third party image thumbnailers which you may prefer for  
your own reasons. As long as you can select an image and drag and 
drop it to another application it should work just fine.

How
Open the image browser of your choice. Navigate to where your 
images are. Select one or more images then drag and drop them 
onto your document. It is that easy.

Illustrator dumps all the images onto the workspace at once.
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Just Use A Text FrameMaking Text

If you click and let go,
the text is stretchable.
It is like art.

If you click and drag, 
the text is re�ow-
able. It is like 
contents in a frame. 

If you click and let go,
the text is stretchable.
It is like art.
If you click 
and drag, 
the text is 
re�owable. 
It is like 
contents in 
a frame. 

Click and Drag
Illustrator has two different kinds of text:

•	 Art‑like - When you select art-like text and resize it, it 
stretches and deforms. When you are done, it is still editable 
though.

•	 Document‑like - When you select document-like text and 
resize it, the text size and shape remains unaltered; the text is 
reflowed to fit the new shape of the bounding rectangle.

When?
The names answer the question. If you are using text to make a art 
with - maybe a logo, or part of a collage - then you probably want 
Art-like. This will allow you to tweak the size to better fit the rest 
of the work.

If you are using text as something people are meant to read as part 
of a document - if you want to make sure that your 10 point type 
remains 10 point - then you probably want Document-like.

How?
•	 Art‑like - Select the Text tool. Click and let go in the docu-

ment. Now you can type. The typing will remain on one line 
until you hit Enter.

•	 Document‑like - Select the Text tool. Click and drag to 
make a rectangle. Now you can type. The typing will appear 
inside the rectangle.
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Just Use A Text FrameAppearance Of  Text

the water 
burst forth 
from spigot 
and faucet, 
tap and bib. 

the water 
burst forth 
from spigot 
and faucet, 
tap and bib. 

the water 
burst forth 
from spigot 
and faucet, 
tap and bib. 

the water 
burst forth 
from spigot 
and faucet, 
tap and bib. 

Appearance
Text in Illustrator has Stroke and Fill. It does not have a containing 
frame with its own Stroke and Fill like InDesign. Stroke and Fill 
can be any color or pattern.

To get a Gradient you have to go into the Appearance panel and 
apply it as a new Stroke or Fill to the Type object not the Char-
acters.
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Illustrator with IllustratorPortability

PDF
Illustrator uses .AI files as its native file format. It also plays nicely 
with PDF files, but PDF can not support everything that Illustra-
tor knows how to do. Stick with AI files.

Older Versions
After the Save As... dialog, Illustrator displays an options dialog. 
On this dialog there is a drop down to let you specify an older 
version of Illustrator. Newer features, for instance image brushes 
from Illustrator CC, or Gradient Strokes from Illustrator CS5, will 
not be able to save correctly to earlier versions. Typically Illustrator 
tries to save something so your file will at least look similar even if 
it can not be edited the same ways.
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Two WaysPhotoshop

One Illustrator file placed four times in Photoshop with different Smart 
Filters applied. The parameters for these filters can be adjusted and the basic 
art can be edited.

Into Photoshop
You can place an Illustrator file in Photoshop. This makes the Illus-
trator file a Smart Object (Photoshop’s version of a linked file) in 
Photoshop which can be freely transformed and subject to effects 
that are applied non-destructively. 

You can also add Photoshop layer masks to a Smart Object.

A placed Illustrator file should look exactly like it did in Illustrator. 
It can be used as a clipping mask for layers above it.

Paste
You can copy objects in Illustrator and then paste them into Pho-
toshop. There are four options when you paste:

•	 Smart Object - Photoshop creates a new Smart Object in the 
Photoshop file. If you tell Photoshop to edit the object it will 
save the object to a temporary file and open it in Illustrator. 
This is pretty cool.

•	 Pixels - lets you transform the object and then rasterizes it to 
a regular Photoshop layer.

•	 Path - puts the shape, outline only, into a new Path, at actual 
size. You can use Edit: Transform Path if you want to change 
the size. The path can then be colored with Fill or Stoke path, 
turned into a selection, and edited as a normal Photoshop 
Path.

•	 Shape Layer - creates a new shape layer with the current fore-
ground color and the pasted shape(s) as a vector mask.
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And Other Image FormatsPhotoshop

The horn is a PNG file with transparency brought into Illustrator, con-
verted to a Symbol and used with the Symbol Sprayer.

From Photoshop
Images can be included in an Illustrator file. They can retain trans-
parency information, be transformed, accept certain effects.

There are two kinds of images in Illustrator:

•	 Linked - The image is a separate file on disk that is displayed 
in the Illustrator document. A Linked image can be turned 
into an Embedded image by Rasterizing it. Use a Linked im-
age if you may want to edit the image in future.

•	 Embedded - The image data is hosted in the Illustrator file 
but it is harder to edit and loses layer content. Embedded 
images are nice because they go wherever the .AI file goes.

Both types of image can be used for Live Trace but there are some 
restrictions.

Restrictions
Linked images can not be used for brushes and patterns and must 
be Rasterized first. 

When Rasterizing, you need to pay attention to your desired DPI 
and whether you want to retain transparency.
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Just PlaceInDesign

From InDesign
It doesn’t look like you can place an InDesign document in an Il-
lustrator document directly, but that might not come up too often. 
But if you really need to, you can save a PDF from InDesign and 
place that in Illustrator.

To InDesign
Just place your Illustrator file as regular image content.

Multiple Artboards
If your Illustrator file has multiple artboards do not place it with 
drag and drop, use the File: Place command off the menu and on 
the dialog check the “Show Import Options” box. This lets you 
chose which artboard you want and

Cropping
...provides some cropping options which can be nice.
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Print to PDFCAD

Clean Up
For a lot of students their introduction to Illustrator is as a way to 
get rid of the student label on their AutoCAD plots. Plot to PDF, 
open the PDF in Illustrator and delete the offending marks.

Is It Good?
Plotting to PDF is a mixed bag for going to Illustrator. The PDF 
maintains all of your line weights, etc. The PDF looks plot ready. It 
is plot ready. But what lines are connected to what other lines and 
which ones aren’t seems pretty random. Solid hatches come in as 
lots of triangles. There may be multiple shapes in one place. It can 
be hard to make edits in a way that seems to make sense. 

Simple things like “select all the lines this big and make them a 
little lighter” work well.

Vector is better 
It is generally better to keep vector art as vectors rather than go to 
bitmap like JPEG or PNG. You can tweak vector art more easily. 
It scales and rotates better.

Always look for the vector option. DWG, DXF, AI, WMF...

Raster if  you have to
If you are having trouble with vector art, most CAD programs 
have a way to create a bitmap. From AutoCAD you can plot to 
a PNG file and you can make it big, like 5000 pixels wide, and it 
should look pretty good.

CAD work is usually very hard edged with areas of flat color and 
high contrast (black lines on white backgrounds). Because of this 
you should use PNG files and not JPEGs. Please.
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Open the DWGCAD

AutoCAD opened in Illustrator and 
different Appearances applied.

Export from Illustrator to DWG. 
Opened and manipulated in Auto-
CAD.

Same drawing with LivePaint and a 
bit of Inner Shadow effect applied.

Illustrator shapes used for build-
ing and original JPEG entou-
rage LiveTraced in Illustrator 
before sending to AutoCAD.
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Illustrator can open AutoCAD’s .DWG files directly. This is prob-
ably the best way to get CAD work into Illustrator if you are going 
to do some heavy editing.

From AutoCAD you have to save as ACAD 2004.

When you open your file in Illustrator there are scaling options. 
You probably don’t need to keep the drawing actual size. If you are 
just making some art, you can use “fit to Artboard”. If you think 
scale might be important, you can specify a scale.

Remember that the AutoCAD units are probably inches so for 
quarter scale you say “12 units = 0.25 inches”.

3D
If you save your file in AutoCAD with a 3d view, Illustrator will 
open the AutoCAD file with that view as 2d art. This is particu-
larly nice for axon site diagrams and landscape work.

Illustrator in AutoCAD
You can export AutoCAD .DWG files from Illustrator. It works 
fairly well.
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Print to PDFCAD

SketchUp
Using the free version of SketchUp the only direct path seems to 
be to print to a PDF. There are two ways to do this. They depend 
on whether the “Use High Accuracy HLR” checkbox on the Print 
dialog is ticked or not. Think of them as:

•	 Technical - Use HLR. The resulting PDF is vector based 
and can be worked as artwork in Illustrator. Artistic styles are 
not preserved, only line weight and solid color fills. It may be 
best to use SketchUp’s plain “Hidden Line” style and do any 
changes in Illustrator. 

•	 Pretty - Don’t Use HLR. Creates a PDF with an embedded 
JPG. This is mostly worthless, because...

SketchUp also offers Export To 2d Graphic. If you do this you can 
select an appropriate file format and on the Export dialog there is 
an Options button which lets you set the size of the final image 
and other useful things.  The drawback of this option is that your 
result is an image not Illustrator objects that can be modified.

You may also want to experiment with moving your SketchUp 
model through another 3d program.

SketchUp Pro offers direct export to EPS format which is about 
the same as a technical PDF.

Rhino
Rhino can export directly to Illustrator’s .AI file format. Curves 
come in as curves though maybe not with the Anchors and Handles 
where you’d expect. Straight linework comes in as multi-segment 
straight lines. Surfaces come in as curves along edges and major 
isocurves. The export respects Print Width for line weights. I do 
not know how to get shaded surfaces or line types exported to AI. 

Rhino can read Illustrator files. Appearances are lost but every 
piece of an Appearance does come in as a separate curve. For in-
stance, a filled shape with a double stroke will come to Rhino as 
three identical shapes in the same place. One for the fill and one 
for each stroke.
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Interaction with ConsumersOutput

Print
You can print directly from Illustrator. Typically each Artboard is 
treated as a separate page and you have the common controls over 
which pages to print. Or you can select “Ignore Artboards” and 
Illustrator will just print all your art. There are also controls for 
scaling.

Presentation
You can save directly to a PDF which will also treat Artboards 
as pages. The PDF can then be shown fullscreen as a slideshow, 
making an adequate presentation. If you have the extra time, it is 
probably a good idea to make the presentation in InDesign with 
the Illustrator art placed on pages. You have easier control over the 
presentation as a unified entity this way.

If you know the PDF will only be used on screen you can save with 
lower quality settings than if you were going to print.

Electronic Distribution
Same comments as for Presentation apply.

Sharing Illustrator
If you need to share your actual Illustrator file, you can just email it 
or whatever. But if you have embeded images or are using uncom-
mon fonts, you should make a Package which will bundle all the 
dependencies together into one folder. You can then zip that folder 
and share it with other parties.
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GradientGradient

Gradient used for Fill, Stroke, Fill and Stroke.

Different gradient modes on a Stroke.

Linear Gradient, Radial Gradient, Linear Gradient with more colors.

Gradient with a transparent pot.

Circle with radial gradient using transparency converted to symbol 
and used with Symbol Sprayer.

Smooth...
Colors do not have to be solid. You can apply a Gradient to Strokes 
and Fills. You can make Swatches for Gradients. There is even a 
Gradient tool.

What?
A Gradient is a smooth blend between colors. 

Gradients also have a type. They can be either Linear looking like 
a planar ramp, or radial looking like a bullseye.

How?
You can apply a gradient to an object by clicking on it with the 
Gradient tool. The Gradient is applied to either the Stroke or Fill 
depending on which square is currently forward, just the same as 
applying color.

Or you can select a Gradient Swatch the same way you would a 
color swatch. The Swatches panel menu has an option to create a 
new gradient swatch.
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Carve Your Own ToolsBrushes

Scatter Brush

Art Brush Stretched Between 
Two Guides

Art Brush

Pattern Brush

How
Select some art then on the Brushes panel menu you can select 
“New Brush...” Or you can just drag the art to the brushes palette.

Then you have to pick between a few different kinds of Brush:

•	 Art Brush - Stretches the art along the stroke.
•	 Art Brush (between) - Keeps the ends from stretching and 

only stretches the middle section. You say where the boundar-
ies are. 

•	 Scatter Brush - Sprays the art along the stroke. Has settings 
for random location, rotation, and size.

•	 Pattern Brush - repeats the artwork along the stroke. Has 
settings for different artwork at start, end, and corners. The 
artwork you start with works automatically but if you want to 
take advantage of the terminal and corner options, you have 
to drag artwork for that onto the Swatches panel to make 
Pattern Swatches out of them. Then they show up in the op-
tions dialog for the Pattern Brush.

Color
Normally a brush based on artwork will be the color of the origi-
nal art. But on the Brush Options dialog there is a section called 

“Colorize.”

If you use black art and set the Brush’s Colorize to “Tints” then 
Strokes come out in whatever color the art is set to. Kind of like 
AutoCAD blocks and Layer 0.

Even More
With Illustrator CC you can make brushes out of Images.
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This Is Diagrammatic?Making Brushes

Three objects used to make an Art Brush and a Pattern Brush.

Three objects with transparency used to make an Art Brush.

Oh Yeah...
Brushes can be made out of more than one object and if the origi-
nal art has transparency, that will be built into the brush.
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GradientGradient

Click and drag sideways to reposition color anchor

Click and drag sideways to reposition peak.

Click and drag away from gradient to delete.

Click in empty space to create new color anchor.

Click and drag to reposition gradient.

Double click to change color and opacity.

Click and drag to resize gradient.
Click near and drag to rotate gradient.

A Pot

Change?
You edit a Gradient by double clicking on the Gradient tool or the 
swatch, or by opening the Gradient panel.

To add a color to a gradient just click on the space under the gradi-
ent. A new pot is made and you can move it.

To change a color in a Gradient select its pot and then change the 
color on the color panel or drag a color Swatch to the pot. Pots 
made from Swatches update if you edit the Swatch.

To remove a color from a Gradient, grab the pot and pull it away 
from the gradient.

In Place
Gradient editing controls can also appear right on top of your art-
work. They appear when you select the Gradient tool and hover the 

mouse pointer over the art. If the Fill Color  
is selected then controls appear if the shape 
has a Gradient Fill. If the Stroke Color tool 
is selected then the controls appear if the 

shape has a Gradient Stroke.

How
The InPlace Gradient Editor works the same as the Gradient 
panel with a few extras. You can reposition the Gradient in the 
object by dragging the circle end of the gradient. You can rotate the 
Gradient in the object by dragging the diamond end.
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Puts Everything in its PlaceAlign

Using Align tools to straighten poorly placed Anchors.

Four objects Aligned to their topmost point.

hkjkjh

Your New Best Friend
It starts off seemingly simple. Just select a few objects and push 
them over to the left of the page. But it is so much more than that. 
I could try to explain it, maybe show a few tricks, but I think you 
just need to get some practice in. Play with it. Touch all the buttons. 
Make mistakes when it doesn’t matter.

I’ll tell you a bit about how I use it, but I think this is one of those 
sections where another user might prefer a different set of tools.

•	 Align Objects - I use this group all the time. Align moves 
objects onto the same line. I align object tops to the top mar-
gin all the time. I also like to align a bunch of objects to either 
their common left edge or centers. 

•	 Distribute Objects - I don’t use this much. Distribute makes 
the distance from one thing to the next the same. If things 
aren’t the same size, this looks bad.

•	 Align to... - In Illustrator I use Align To Selection far more 
than Align to Artboards.

“To Artboards” moves objects away from where they are and 
snugs them up against the edge of the artboard.

“To Selection” leaves the objects roughly in place and makes 
adjustments as needed. I love this for snugging captions under 
art, or making sure a column of art is on the same line.

•	 Distribute Spacing - It makes sure the spacing between ob-
jects is equal and looks pretty. 

Even Better
Unlike InDesign, you can use the Align tools to arrange Anchors. 
Use the Direct Select tool to select the anchors then hit an Align 
button.
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Don’t Cover It OverClipping Path

Make art. Create clipping art. Embellish.

Some Clipping: Before After

Hide it Inside
Sometimes art needs to be limited by an over-riding shape. Some-
times just covering it up with a white rectangle is the easiest thing 
to do. Sometimes the shapes lend themselves to using one of the 
Pathfinder options.

And sometimes the art is too complex, or too unrelated to the con-
straints for those to be good options. (Covering with a white rect-
angle is probably never a good option.) For those times there are 
clipping paths. A clipping path is like an InDesign Image Frame 
or an AutoCAD viewport.  The actual artwork is larger than the 
constraining frame, but it does not appear outside the frame.

How
Create the artwork to be seen. Then create the artwork that will 
become the clipping path. If the path is made up of more than one  
shape, select all the shapes and convert them to a Compound Path 
(it’s on the right click menu and on the Object menu). 

On Top
The art that will be the Clipping Path must be in front of anything 
that is to be clipped. Illustrator just uses whatever is in front for the 
path; it isn’t psychic; “Can’t it tell that I meant this to the Clipping 
Path?” “No.” See “Display Order” on page 22 for help with this.

All At Once
Select the art to be clipped and the art to do the clipping. Then 
“Make Clipping Path”. It’s on the right click menu and on the Ob-
ject menu. There, you’re done.
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Don’t Cover It OverClipping Path

Multiple shapes works. Use “Make Compound Path” first.

Art inside a clipping path can be moved 
and altered. The clipping path itself can 
also be altered.

Where’d It Go?
When you make a clipping path Illustrator gets rid of the clipping 
path’s Appearance attributes. You can go back and give it a Stroke 
if you wish. But nothing fancy: only width, color, and dashed. No 
brushes or multi-stroke.

Multiple
You can make a single Clipping Path out of more than one shape. 
To do so, select all the shapes that will be the path then Make 
Compound Path. Make sure the Compound Path is in front and 
then clip.

Live
The shapes that make up the Clipping Path and the artwork inside 
it are all still live. You can edit them in any normal way. Some edits 
are easy to make with the Direct Selection tool. Others may be 
easier if you go into Isolation Mode, which this document does 
not talk about.
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SmoothBlend

Make two shapes.

Click on them with the blend tool.

You can use more than one shape.

The main shapes can be edited and the 
path of the blend can be edited.

From Here To There
Blend takes two or more shapes and fills in the space between 
them with a smooth morph from one shape to the next.

Both shape and Appearance are morphed. Sometimes unbelievably. 
See the example below that Blends between a railroad and a two 
lane country road. 

OK, just now I tried to make a blend that wouldn’t make sense. It 
is possible. Ick.

OK, I tried a little harder and Illustrator 
blew me away. So I’ll just 
leave this here so you 
have an idea of 
what kind 
of thing is actually 

possible with almost no 
effort or planning what-so-ever.

How?
Create the primary art - each end. Select the Blend tool 

and click on each end. You may not get the blend that you want. 
Make sure the Blend is selected and double click on the Blend tool, 
or go to the menus Object: Blend: Blend Options.

If the Appearances of the end objects are easy enough, Smooth 
Blend works well, like the first examples to the left. If it’s harder, 
sometimes Illustrator just puts one morph in the blend instead 
of doing a nice smooth job. You can set the option to Specified 
Number of Steps and just put in a high number.

For more shapes, just click on more shapes.

Use the Direct Select tool and Convert Anchor tool to adjust 
shapes and paths.
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Old School Airbrush EffectsMesh

One click with Mesh tool.

Some more Anchors colored.

Starting shape.

More Anchors added and Handles modified.

Color Per Anchor
You can fill an object with a grid of Anchors and give each anchor 
a color and adjust handles. Some people are doing photo-real por-
traits this way. It is also helpful where you want a Gradient but 
Gradients are too limited.

How?
Create a shape. Select the Mesh tool and click on the shape.

Now use the Direct Select tool to select Anchor points in your 
mesh. Change the Fill color of the Anchors to color your mesh. 
Move Anchors and adjust Handles to modify the color flow.

Click with the Mesh tool to create more Anchors.

If you like Meshes, look into a plug-in called Mesh Tormentor.
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Where Do I Go Next?Help

Getting Help
This introduction has been brief and shallow. I hope it has been 
enough to get you started. Bring your own curiosity and sense of 
play and you should go far. But still, you can get stuck. I won’t even 
begin to count how many times I went for help just in putting 
together this little book. So, where can you go?

•	 Menu - Illustrator does have a help menu. You might con-
sider looking at that. But I usually do that second.

•	 Google - Ask the web. Ask long questions. Try to use the 
best words to describe the problem. Somebody probably had 
the same question already. Often enough the first thing in the 
results is the online Adobe Help page for the subject. But you 
get to it quicker than trying to find it through the Help menu. 
So I go here first.

•	 Ask Around - somebody in the room or on your favorite so-
cial media option might know.

•	 Learning Resource Center - The LRC at the BAC can get 
you in touch with tutors.

•	 YouTube - there are a lot of Illustrator videos available.
•	 AdobeTV - online training from Adobe. Most of it is pretty 

good. Some of it is geared towards a long episode rather than 
a quick thirty second tip, but it’s worth watching.

•	 Podcasts - there are podcasts for tips and tricks. I don’t use 
them to look up answers, but you can pick stuff up and file it 
away for later. 

•	 Dedicated Sites and Blogs - These have tutorials and forums 
where you can find answers. They often come up in search 
results for specific questions.

•	 Professional Training - there are many good web sites offer-
ing training videos and DVDs. I have used a few of the free 
videos on Lynda.com and liked them.

•	 IRL School - take a class in real life


